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Introduction to the manual 

Introduction to the manual 

What this chapter contains 
The chapter describes the intended audience, compatibility and the contents of this 
manual. It also includes the safety instructions. 

Compatibility 
The document is valid for DriveBrowser PC tool version 1.1 or later.  

Safety instructions 
Follow these instructions when using the DriveBrowser PC tool. 

WARNING: Ignoring the following instructions can cause physical injury or death, or 
damage to the equipment. 

• When using the control panel, you can be far a way from the actual motor. 
Make sure that starting and stopping the drive can be done safely. This 
includes but is not limited to attempted remote control of a drive 
utilizing the Drive Control Panel within Drive Browser. Any attempt to 
control the drive from a remote location through a communications 
switch, which in order to allow this Browser control to function, a 
choice is made to disable communications loss faults because of the 
inherent timing delays of the Internet and communications switches or 
other devices. Without the communication loss fault function enabled 
the drive can lose communications while still in a run mode, this is an 
unsafe condition. Do not operate the drive in an unsafe condition. 

• Parameters that are edited with DriveBrowser are not saved to drives 
permanent memory unless requested by the user. 

See also the safety instructions of the connected drive. 

Reader 
This manual is intended for persons who install and use the DriveBrowser PC tool.  
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Overview of DriveBrowser 

Overview of DriveBrowser 

What this chapter contains 
The chapter describes the intended audience, compatibility and the contents of this 
manual. It also includes the safety instructions. 

Overview 
DriveBrowser is a maintenance tool for the ACS350, ACH550, ACS550 and 
ACS800* drive series. 

DriveBrowser PC tool is designed to run under the Microsoft Windows 2000, 
Windows XP, Windows Vista and Windows 7 operating systems. 

The key functions of DriveBrowser PC tool are the following: 

• Make lists of drives and their IP addresses 

• Connect one by one to listed drives 

• Show the actual status of the connected drive 

• View and edit the drive parameters 

• Read parameters from drive to PC and transfer parameters from PC to drive 

• Monitor drive signals graphically and numerically  

• Control a drive 

* ACS800 standard control program, 
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Getting started 

Getting started 

What this chapter contains 
This chapter describes how to install the DriveBrowser to a PC and how to connect 
the PC to a drive via RETA-01, RETA-02 or FENA-01 fieldbus module. 

Computer requirements 
To operate DriveBrowser, your computer should meet the following minimum 
requirements: 

Table 1.  System requirements 

Category Minimum Requirement 

Operating System Windows 2000, Windows XP, Windows Vista and 
Windows 7 

Display 1024x768, 256 colors 

Hard Disk Space 80 MB 

 

Delivery check 
Package includes DriveBrowser CD and registration information. 

Connecting drive and PC 
DriveBrowser uses PCs Ethernet connection to communicate with the drives. 

On the drive side, an Ethernet fieldbus module is required. For ACS350, FENA-01 
is needed and for ACH550 and ACS550 a RETA-01 or RETA-02 is needed, for 
ACS800 a RETA01 or RETA-02 Is needed. For installation of the fieldbus module, 
see corresponding user manual. Module in the drive should be activated from group 
98 prior it can be used.  

Fieldbus module and the PC can be connected in two ways: point to point or a 
network.  

Point to point connection 

In point to point connection, a crossover Ethernet cable between the module and 
the PC as in figure 1 is used. In such a case, the IP address and the subnet mask 
of the PC and the module is defined manually.  
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Figure 1.  Point to point connection with a crossover cable.  

 

To configure the PCs IP address, open Network Connections of the PC. 

 

 
 

After click the Network Connections window is presented. 
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Double click the used connection and a Local Area Connection Setup window is 
presented. 

 

 
 

Click the Properties. 
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Select Internet Properties (TCP/IP) and click OK. 

 

 
Figure 2. Internet Protocol (TCP/IP) Properties. 

 

Select Use the following IP address, then type in the IP address and the Subnet 
mask. There is no need to define the Default gateway. Click OK to accept changes. 

For configuration of the module, see corresponding module manual. With ACS350, 
ACS550, ACH550 and ACS800, the module is activated from parameter 9802. IP 
address, subnet mask, used protocol etc. are selected from group 51. 

Note! Configuration of the module is done with DriveWindow Light or the control 
panel. This is because DriveBrowser is not able to communicate with the module 
before these settings are in use. 

 

Network connection 

 

Another way for connection is to use an Ethernet network. Standard Ethernet 
cabling is used between the PC and a switch and the module and the switch as in 
figure 3. 
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Figure 3. Network connection with an Ethernet switch. 

 

In a network, an IP address and a subnet mask is set automatically by DHCP 
server to all network components or they are configured manually.  

Note! DriveBrowser is intended to be used inside one firewall zone. If you want to 
use it outside firewall, please contact your local IT administrator to advise with 
firewall settings. 

Network connection with DHCP server 

 

In a network that contains a DHCP server, the IP address and subnet mask are 
configured automatically. All communication components connected to the 
network should be configured in a way that they use the IP address and subnet 
mask given by the DHCP server.  

Check PCs configuration from Network Connections as described in section 
Point to point connection. PC should configured in a way that it obtains IP 
address and subnet mask automatically. 
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For configuration of the module, see corresponding module manual. With 
ACS350, ACS550, ACH550 and ACS800, the module is activated from 
parameter 9802. IP address, subnet mask, used protocol etc. are selected from 
group 51. 

Note! IP configuration of the module should be set to DHCP or DHCP should be 
enabled from group 51. 

 

Network connection with static IP configuration 

 

In a network that does not contain a DHCP server, the IP address and subnet 
mask are configured manually. All communication components connected to the 
network are configured in a way that their IP address and subnet mask are 
defined manually.  

Check PCs configuration from Network Connections as described in section 
Point to point connection. PC should be configured in a way that it uses the IP 
address and the Subnet mask defined by the user. If there are modules outside 
given subnet mask, also the Default gateway should be given. 

For configuration of the module, see corresponding module manual. With 
ACS350, ACS550, ACH550 and ACS800, the module is activated from 
parameter 9802. IP address, subnet mask, used protocol etc. are selected from 
group 51. 

Note! IP configuration of the module should be set to Static or DHCP should be 
disabled from group 51. 

Installing DriveBrowser 
Please read carefully the license agreement (License.pdf) before installing 
DriveBrowser. You should quit all applications before starting the installation. We 
recommend that you uninstall all previous versions of DriveBrowser before 
installing. 

Note! You should have Administrator privileges to be able to do the installing. 

Your PC may be configured in such a way that when you insert the DriveBrowser 
installation CD into your CD drive, installation starts automatically. Answer the 
questions and follow the instructions given by the installation program. 

If installation does not start automatically, you can start the SETUP program from 
the Control Panel as follows. 

Start the Control Panel program and double-click the Add or Remove Programs 
icon. 
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Click the Add New Programs button and then the CD or Floppy button. 

 

 
 

Insert the DriveBrowser installation CD into your CD drive and click the Next > 
button. 

If the proper SETUP was not found automatically, enter E:\SETUP.EXE into the 
Command line for installation program (assuming E: is your CD drive), or click the 
Browse button and select the program by browsing. Finally click the Finish button, 
which starts the SETUP.  

When the DriveBrowser installation wizard window is shown, click the Next > 
button. 
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Next screen asks to accept the license agreement. 

 
 

Next screen asks where to install DriveBrowser. If the default location is OK, just 
click the Next > button to continue. Otherwise click the Browse button to define 
another location. 
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Next screen asks where the DriveBrowser shortcuts are installed. If the default 
location is OK, just click the Install  button to continue. 

 

 
At the end the installation, user is prompted to select if the language for 
DriveBrowser user interface is English. Click Yes to select English, click no to select 
German. 
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After the files are copied to the specified location on your hard disk, click the Close 
button to end the installation procedure. DriveBrowser is now ready for you to use. 

 

 
 

 

Starting DriveBrowser 
To start DriveBrowser, select Start – Programs - DriveWare – DriveBrowser 
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User interface 

What this chapter contains 
This chapter describes the main user interface of the DriveBrowser. 

Overview 

 
The user interface consists of the following parts: 

1. Title Bar 

2. Menu Bar 

3. Control panel 

4. Connection setup 

5. Window area 

1 
2

3 

5 

8 

7 

6

4

9
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6. Drive status 

7. Monitor  

8. Status bar 

9. Advanced status 

 

Title bar 

 
 

 

The title bar is located at the top of the main window. It consists of the following 
parts: 

1. System menu button 

2. Application name and version number (DriveBrowser) 

3. Minimize button, same as Minimize in the System menu. Reduces the main 
window to the Taskbar or a sub window of the main window to the window 
area. 

4. Maximize / Restore button (depends on current maximized status of the 
window), same as Maximize or Restore in the System menu. 

5. Close button, same as Close in the System menu 

To move the window, drag the title bar. You can also move dialog boxes by 
dragging their title bars. Note that maximized or minimized windows cannot be 
moved. 

Maximize of the Maximize / Restore button enlarges the window to fill the available 
space. 

Restore of the Maximize / Restore button returns the window to its size and position 
it had before you chose Maximize. 

You can also do maximizing / restoring by double-clicking the title bar. 

Clicking close button ends your DriveBrowser session. 

You can close DriveBrowser also by double-clicking the system menu button, by 
selecting Exit command in the File menu, by selecting Close from the System 
menu, or by pressing the keyboard shortcut Alt+F4. 

1 2 3 4 5 
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System menu 

 
You can open the System menu by left- or right-clicking the System menu button, 
by pressing the keyboard shortcut Alt+Spacebar, or by right-clicking within the non-
button area of the title bar. 

Many dialog boxes also have simple system menus. You can open their System 
menu, in addition to clicking the button, by right-clicking within the non-button area 
of their title bar, or by pressing the keyboard shortcut Alt+Spacebar. 

The menu contains the following commands: 

• Restore command, the same as the Maximize / Restore button in the title bar, 
when the window is maximized. Returns the window to its size and position 
before you chose maximize. 

• Move command, similar to dragging the title bar. After selecting the command, it 
is possible to move the window with the arrow keys. To finish the moving, press 
Enter. To cancel the moving, press Esc. 

• Size command, similar to dragging any of the sides or corners of the window. 
After selecting the command, it is possible to resize the window with the arrow 
keys. To finish resizing, press Enter. To cancel resizing, press Esc. 

• Minimize command, same as minimize button in the title bar. Reduces the 
window to the Taskbar or the window area. 

• Maximize command, same as the Maximize / Restore button in the title bar, 
when the window is not maximized. Enlarges the window to fill the available 
space. 

• Close command, same as close button in the title bar. Ends your DriveBrowser 
session. DriveBrowser possibly warns you about releasing control, prompts you 
to save documents with unsaved changes, or reminds you about unfinished 
printing. 

Menu bar 

 
The menu bar is located immediately below the title bar. It always contains the 
following drop-down main menus: 

• File 

• Edit 
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• View 

• Drive 

• Parameter browser 

• Monitor 

• Window 

• Help 

 

To open a drop-down menu, click its name on the menu bar. You can also use the 
underlined letter in the menu name. Press and hold down the Alt key first, then 
press the key of the underlined letter and release both. For example, Alt+F opens 
the File menu. 

To execute a command from a menu, click its name on the menu. You can also use 
the arrow keys to navigate within the menu bar and menus. The highlighted 
command is executed by pressing Enter. Pressing Esc key closes the menu. You 
can also use the underlined access key in a command name to execute the 
command. For example, pressing X, while the File menu is displayed, executes 
Exit. 

To get help about command on a menu or submenu, use the arrow keys to highlight 
the command, and press F1. 

Note! Keyboard shortcuts other than F1 do not work while a menu is dropped-
down. 

File menu 

 

 
The menu contains the following commands: 

• Open command presents a dialog for opening a parameter or monitor file into a 
PC. Keyboard shortcut Ctrl+O. 

• Close command closes the active window of DriveBrowser. 

• Save command saves the Browser file into a PC. Keyboard shortcut Ctrl+S. 

• Save As… command presents a dialog for saving the Browser file into a PC with 
a new name. Keyboard shortcut F12. 
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• Print command presents a dialog for printing the active document. Keyboard 
shortcut Ctrl+P. 

• Print setup… command presents a dialog for changing the printer and the 
printing options.  

• Exit command ends your DriveBrowser session. DriveBrowser possibly warns 
you about releasing control, prompts you to save changed parameters to drives 
permanent memory, or reminds you about unfinished printing. Keyboard shortcut 
Alt+F4. 

Edit menu 

This menu is always located in the menu bar. 

 
The menu contains the following commands: 

• Undo command cancels the latest command if it is possible. Keyboard shortcut 
Ctrl+Z. 

• Cut command removes selected objects and puts them on the clipboard. Not all 
objects can be cut and they vary between different views. Keyboard shortcut 
Ctrl+X. 

• Copy command copies selected objects and puts them on the clipboard. Not all 
objects can be copied and they vary between different views. Keyboard shortcut 
Ctrl+C. 

• Paste command inserts the clipboard contents. Availability of the command 
depends on the active view and contents of the clipboard. Keyboard shortcut 
Ctrl+V. 

• Confirmations and options… command presents a dialog for setting 
DriveBrowser behavior. 

• Drive connections setup… presents a dialog for presenting drives and their IP 
addresses to DriveBrowser. 

• Monitor Settings… command brings up the Monitor Settings window where the 
Monitor settings can be modified. This is the same command as the 
corresponding button in the toolbar. 
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View menu 

 

 
The menu contains the following commands: 

• Drive control panel command shows or hides the control panel interface. 

• Advanced status command shows or hides the advanced status. 

• Status bar command shows or hides the status bar. 

• Monitor command launches the monitor window. 

Drive menu 

 

 
The menu contains the following commands: 

• Set new reference… command is active only when the connected drive is 
configured to get the speed or frequency reference from the fieldbus module. 

• Start command is active only when the connected drive is configured to get the 
start and stop command from the fieldbus module and drive is in stopped state. 

• Stop command is active only when the connected drive is configured to get the 
start and stop command from the fieldbus module and drive is in started state. 

• Reset fault command resets an active fault from the drive. 

(NOTE: Please refer to the warnings and notes in the  “Introduction to the manual” 
“Safety Instructions” section on page 7) 
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Parameter browser menu 

 

 
The menu contains the following commands: 

• Parameter Subset… command brings up a window where a number of 
parameters can be chosen from several groups to be displayed in a separate 
subset group. 

• Expand groups command shows all visible groups and their parameters in the 
list. 

• Collapse groups command shows only the group names in the list. 

• Read from drive command is used to refresh the drive connection after a 
network break.  

• Copy parameter file to drive… command opens a dialog in which you can 
choose a source for parameter copy function. See Chapter xx Copying 
parameters for further information. 

• Save to permanent memory command sends a parameter save request to the 
target drive. 

• Search parameters command brings up a dialog asking for a word to search 
from the names of the visible parameters. Keyboard shortcut Ctrl+F. 

• Compare parameters with… command brings up a dialog asking for a reference 
file or drive and target file or drive for comparison. 

 

Window menu 

 

 
The menu contains the following commands: 
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• Cascade command arranges the open windows so that they overlap. 

• Tile command arranges the open windows as non-overlapping tiles. 

 

Help menu 

 

 
The menu contains the following commands: 

• Contents and index command brings up the online help window and shows its 
topics. 

• About DriveBrowser… command brings up a window displaying program 
information, version number and copyright. 
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Drive status 

What this chapter contains 
This chapter describes how to use the Drive status panel. 

Drive status panel 
The Drive status panel is located on the left side of the DriveBrowser main window.  

The Drive status panel shows the following information about the drive:  

• type of the drive, to which DriveBrowser is connected to 

• control mode of the drive 

• status: running or stopped 

• output frequency [Hz]  

• current [A] 

• power [kW] 

• speed [rpm] 

• drive state (OK, Warning or Fault). 

The lower part of the Drive Status panel contains the following function buttons:  

• Parameter Browser – changes to the Parameter Browser window 

• Monitor – changes to the Monitor window. 

 

   
Figure 4.  Drive status 
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Status bar 
The Status bar, located at the bottom of the screen shows the drive and connection 
status.  

To view or hide the status bar, select Status Bar from the View menu.  

 

 

 

 
Figure 5.  Status bar 

 

Advanced status 
Advanced status is located under the menu bar if control panel is not shown. 
Otherwise it is located on the right side of the control panel. Advanced status shows 
the status word and control word of the drive. Status words are shown both in 
hexadecimal and binary format.  

 

 
Figure 6. Advanced status with a tooltip 

 

Control word and status word are defined by parameters 301 and 303, see drive 
manual for further detail. DriveBrowser present the advanced status as a tooltip 
when cursor is moved on the top of the status box.
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Parameters 

What this chapter contains 
This chapter describes how to use the Parameter Browser to view and edit 
parameters and actual signals. 

Parameter Browser 
You can use Parameter Browser to view and edit the parameters.  

Parameter Browser is opened when a connection to drive is established. Parameter 
browser can also be opened by clicking the Parameter Browser button located 
under the Drive status. 

For a list of parameters and their descriptions, see chapter Actual signals and 
parameters of the user manual of the connected drive. 

 

 
Figure 7.  Parameter Browser  
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Opening and closing parameter groups 

• To open a parameter group, click the plus sign in front of the group or double 
click the group. 

• To close a parameter group, click the minus sign in front of the group or double 
click the group. 

• To expand all parameter groups, select Parameter Browser – Expand all 
Groups.  

• To collapse all parameter groups, select Parameter Browser – Collapse all 
Groups. 

Editing and viewing parameters and signals 

The Parameter Browser shows the parameters and the signals of the drive. Signals 
as well as some other parameters protected by drive are marked with a lock sign, 
where as the parameters don’t have an icon at all. 

To edit a parameter, double click its value and either type in the new value or select 
it from a list. 

Signals are like parameters, but you cannot edit their values. 

Note! If monitor has not been started, all shown parameter and signal values are 
updated cyclically in the Parameter Browser.  

Saving parameters to a file 

• To save the parameters in a DriveBrowser Parameter file, select Save or Save 
as… from the File menu or click the save button in the toolbar. 

• To open a parameter file and read the parameters, select Open from the file 
menu. The files are in UNICODE format with semicolon delimiters and can be 
opened with most spreadsheet applications. However it is recommended not to 
edit them with other tools than DriveBrowser. 

Copying parameters to drive 

• To copy parameters to a drive, connect DriveBrowser to the target drive, then 
select Copy parameters to drive… from the Parameter browser menu or click 
corresponding icon in the Parameter browsers toolbar. 

• To save parameters to drive’s flash memory, click Save to permanent memory 
button. 

Note! Parameter values are not saved automatically to drives permanent memory 
when they are changed via field bus. However if values are not saved when 
DriveBrowser is closed, used is prompted to save values to permanent memory. 
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Table 2.  Parameter browsers toolbar buttons 

Icon Function 

 

Save 

 

Read from drive, same as F5 

 

Copy parameter file to drive 

 

Save to permanent memory 

 

Uploading parameters from drive 

Upload and upload all parameters functions are needed when monitor has been 
started. At all other times parameter and signal values are read cyclically to the 
Parameter browser. 

• To upload a parameter or a signal value or all values from a parameter group, 
select parameter or group, then select click the mouse secondary button and 
select Upload. 

• To upload all parameter and signal values, click the mouse secondary button 
and select Upload all parameters. 

Compare parameters 
To compare parameters in the active Parameter Browser window with another 
Parameter Browser window or a DriveBrowser Parameter (DWP) file, select 
Compare parameters with... from Parameter Browser menu. 

The Result window shows the differing parameter/group names in the first column. 
The second column shows the value in the active browser and the third column the 
value in the other browser window or parameter file.  

The comparison is based on the parameter number, which consists of the group 
number and the parameter’s index within the group. The values of the parameters 
are compared only if both the numbers of the parameters and their names are the 
same. Otherwise the result shows that the parameter or parameter group is missing 
(n/a) from either source.  
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Figure 8.  Results of Compare Parameters 
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Drive control panel 

What this chapter contains 
This chapter describes how to use the Drive control panel to control the drive. 

Operation 
Drive control panel is hidden as a default. To view or hide the Drive control panel, 
select Drive Control Panel from View menu or uncheck Control panel hidden 
checkbox from Options and Confirmations. 

CAUTION! DriveBrowser does not disable the control capabilities of other devices, 
such as PLC’s, while DriveBrowser is connected to the drive. Control devices such 
as PLC’s may still issue control commands that the drive will respond to. Users 
need to be aware of all control devices that may issue commands to the drive while 
connected with DriveBrowser  (NOTE: Please refer to the Notes in the  
“Introduction to the manual” “Safety Instructions” section on page 7) 

You can use the Drive control panel to control the drive operation if the drive has 
been configured to be controlled via communication module. See corresponding 
drive manual to enable all functions of the control panel. At least following should 
be configured 

• Start/stop parameter of active control place includes COMM selection 

• Reference of active control place includes COMM selection 

• Fault reset selection is set to COMM 

All drive operation commands are found from the Drive menu too. The Drive control 
panel has the following buttons: 

 

Table 3.  Drive control panel buttons  

Buttons Function 

 

Drive is in external control 

 

Drive is in local control 

 
Reset the active fault on drive 

 
Start the drive  

 
Stop the drive  

 
Fieldbus reference edit box, see drive user manual for 
details 

 
Download the fieldbus reference to drive 
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Figure 9.  Drive control panel  

To control the drive with DriveBrowser, drive should be in external control and 
active control place should have fieldbus (COMM) as a source for control. To reset 
a fault from a drive, the fault reset source should be set to fieldbus (COMM). See 
drive manual for details. 

If the DriveBrowser is closed and the drive was started by the DriveBrowser during 
the session and the control panel is active, user is prompted to stop the drive 
control. 

 

 
 

Note! If the DriveBrowser.exe operation is ended with task manager and drive was 
in local mode and started, drive will be stopped.
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Drive monitoring 

What this chapter contains 
This chapter describes how to use DriveBrowser to monitor the operation of the 
connected drive. 

Operation 
You can use DriveBrowser to monitor the operation of connected drive. The 
operational values can be shown in both graphical and numerical format and 
monitoring data can be saved to a file for later use. Monitoring is controlled with the 
Monitor toolbar. 

 
Figure 10.  Monitor toolbar  

 

The Monitor toolbar has the following buttons: 

 

Table 4.  Monitor toolbar buttons  

Button Function 

 
Monitor settings 

 

Start lasso zoom. An area can be selected with the 
mouse. Lasso zoom mode can be disabled with a 
second click on this button. 

 
Zoom in the trend line graph 

 
Zoom out the trend line graph 

 
Clear the monitoring data from the numeric screen, from 
the graph and from application's memory 

 
Start monitoring 

 
Stop monitoring 

 

Show monitor data in numerical format. You can open 
several numerical windows in order to compare 
monitoring data. 
Note! In numerical format the values are shown 
multiplied with the coefficient set either manually or 
automatically. 

 
Activate auto scroll. Scrolls automatically to the 
rightmost position. 
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Monitoring settings 
You can select the monitored signals and define the monitoring settings in the 
Monitoring settings dialog. Max number of signals to be monitored is 4. 

To open the dialog, select Monitor settings from Monitor menu or click the Monitor 
settings button in the Monitor toolbar.  

There are two kinds of settings: global settings and signal-specific settings.  

Global settings are identical for all signals. 

You can set the signal-specific settings individually for each signal. First, select the 
signals displayed in the drop-down menu in the Start Monitoring dialog.  

Click the Select… button next to the signal drop-down menu and select the signals 
from the list. 

 

 
Figure 11.  Select signals to be monitored 

 

Expand a group by clicking the + sign in front of the group (as group 1 in figure 11) 
and check the signal check  boxes to be monitored. Then click the >> button to add 
signals to Selected parameter list. Signals can be removed from the list by selecting 



39 

Drive monitoring 

first a parameter to be removed, then click << button. To remove all signals, click 
<< All button. 

 

After you have selected the signals, they are displayed in the drop-down menu. 
Select the signal to define the signal-specific settings for it. (In the figure below, 
signal 0102 Actual Frequency1 is selected).  

 
Figure 12.  Monitoring settings  
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Table 5.  Global monitoring settings  

Dialog Item Meaning 
Sample Interval (ms) Sample interval in milliseconds. 

Manual Y-axis Set the minimum and maximum values of the Y-axis 
manually. 

Auto Y-axis The minimum and maximum values of the Y-axis are 
calculated automatically. 
Note! The values are calculated when enabling auto 
mode and when in auto mode closing the parameter 
subset selection window. 

Max Y-axis Maximum Y-axis value. In Auto Y-axis mode the value 
for Y-axis maximum is the biggest maximum value of the 
monitored parameters. 
Note! The positive Y-axis values are limited to be under 
200 000. 

Min Y-axis Minimum Y-axis value. In Auto Y-axis mode the value for 
Y-axis minimum is the smallest minimum value of the 
monitored parameters. 
Note! The negative Y-axis values are limited to be over -
200 000. 

Amount of Samples The number of samples stored in the RAM. The value 
should be between 1 000 and 1 000 000. 

X-axis length The length of the X-axis in seconds. 

Enable Point Marks Show point marks to represent actual samples in the 
trend lines. 

 

 

Table 6.  Signal-specific monitoring settings  

Dialog Item Meaning 
Select Select a maximum of four signals for monitoring. 

Monitoring signals are selected with the parameter 
subset selection dialog. 

Manual Coefficient Set the coefficient value for the signal selected in the 
drop down list. The actual sample values received from 
the drive are multiplied by this value. Coefficients can 
be used to scale signals in order to improve clarity. 

Auto Coefficient The coefficients are calculated automatically based on 
the maximum values of the monitored signals and the 
maximum value of the Y-axis. 
Note! Auto coefficients are calculated when the 
Monitoring Settings window is closed. 
Note! Manual or Auto Coefficient selection is the same 
for all monitored signals. Only the actual coefficients 
are signal specific. 

Monitor Stopping Monitoring can be stopped manually with the button in 
the Monitor Toolbar or automatically when the defined 
stopping condition is reached. 

After conditions You can define the stopping condition separately for 
each of the signals. The monitoring is stopped if any of 
the stopping conditions is true. You can also define the 
monitoring to continue for certain duration after 
reaching the stopping condition. 
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File operations 
To save the monitoring data to a file, select Save from file menu.  

To open a monitor file, select Open from File menu.  

Note! The Monitor window should be active when saving or loading the monitor 
data. 

Note! Monitor file can only be opened if Parameter browser is open. 
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Settings 

What this chapter contains 
This chapter describes how to change the connection settings ,options and 
confirmation settings. 

Connection setup 
Connection setup is launched from a button just above the Drive status. In this 
window, you can create new, open or edit existing drive lists, set Ethernet adapter 
IP addresses and modify default connection. 

Create a new drive list by clicking New button. Click Add to add to drive and its IP 
address. After all drives have been added, save list with the Save... button. 

To open an existing drive list, click Open… 

To remove a drive from a list, first select a drive, then click Remove button. 

To add a drive, click Add button. 

 

 
Figure 13.  Drive connections setup window  
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To set IP addresses of the Ethernet adapters using DriveBrowser, click Set 
Ethernet adapter IP address… button, type in both the IP address and the MAC ID 
then click the Set button. 

 

 
Figure 14.  Set Ethernet adapter IP address window with an error message.  

Note! After setting the IP address, DriveBrowser tests the connection using ping. 
Ping gives an answer if it finds requested IP address even though the used MAC ID 
would be false. 

After Drive connection setup has been made, you can select target drive from a 
drop down list that is located just above Connection setup button. 

 

 
Figure 15. List of configured drives. 

CIP Bridging and Routing / DeviceNet / ControlNet 

For bridging and routing from EtherNet/IP to DeviceNet you need to have the ABB 
SEDG-01 EtherNet/IP / DeviceNet gateway hardware (3AUA0000051448). For 
bridging and routing from EtherNet/IP to ControlNet you need to have the ABB 
SECG-01 EtherNet/IP / ControlNet gateway hardware (3AUA0000051449).  Please 
read corresponding manual for installing it. The following example shows how to 
set-up DriveBrowser with the SEDG-01 EtherNet/IP /DeviceNet gateway. 

Launch connections setup 
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Figure 16. List of configured drives. 

Double click on the column Bridging & Routing and the following display opens: 

 
Figure 17. CIP Bridging and Routing. 

Figure18 shows example of CIP Bridging and routing. In this example the gateway 
hardware has a Port ID = 2 to EtherNet/IP and target device(drive) MAC ID = 5. 
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Figure 18. Example for EtherNet/IP / DeviceNet routing 

 
Figure 19. CIP Bridging and routing as in figure 19 

The Modbus/TCP or Modbus/UDP connection is tried first. After that the 
EtherNet/IP connection is tried. However, if EtherNet/IP CIP Routing and Bridging is 
enabled the Modbus/TCP or Modbus/UDP connection is not tried. 

 

Note! ABB SEDG-01 DeviceNet/Ethernet_IP gateway uses Port ID 3 for DeviceNet 

Note! More info about DeviceNet routing can be found from root of installation CD. 
Document ABB EtherNet/IP Bridging and Routing to DeviceNet.pdf 

 

 

 

Confirmation and options 
You can set DriveBrowser to show confirmation dialogs for critical operations. To 
select the desired confirmations, select Confirmation and options... from Edit menu 

In options, user has the possibility to activate control panel. 
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In Confirmations, user has the possibility to select functions that need a 
confirmation before they are executed. For example, if you click an active start 
button in the Control panel, user is asked ‘Are you sure you want to start the 
drive?’. The default settings are shown in the figure 17. 

Note! As a default, DriveBrowser does not show Control panel. 

 
Figure20.  Confirmations and Options dialog 
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Keyboard shortcuts 

What this chapter contains 
This chapter describes keyboard shortcuts used in DriveBrowser. 

Keyboard shortcuts 
 

Table 7.  Keyboard shorcuts used in DriveBrowser  

Function Key  

Close window Ctrl + W  

Copy Ctrl + C 

Cut Ctrl + X 

Exit Alt + F4  

Help F1 

New Parameter browser window Ctrl + N 

Open  Ctrl + O  

Paste Ctrl + V 

Print Ctrl + P  

Read from drive F5 

Save Ctrl + S  

Save as F12 

Search parameters Ctrl + F  

Undo Ctrl + Z 
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